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10 Plane Curves, Polar Curves

In this chapter the emphasis is on curves in the plane which are not represented by an explicit
functional relation of the form y = f (x) : An important method of describing such curves is
parametric equations, where each of the spatial variables (x; y) is given in terms of another variable,
the parameter (t) : For example consider the curve traced out by a point P on the circumference
of a circle rolling around the outside of another circle. Such a curve is called an epicycloid and is

illustrated below.
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Trying to describe one variable in terms of the other in this case leads nowhere. However, if we try
to describe the position of the point P in terms of angles (parameters) the point P makes with the
centers of the circles, we can arrive at a set of parametric equations for the motion.

A special case of parametric equations arises when we use polar coordinates and describe curves in
terms of polar variables r and µ:

This chapter includes two laboratory assignments. The ¯rst assignment emphasizes parametric
equations in general. Using Mathcad will enable you to graph and ¯nd arc lengths and areas
enclosed by curves given parametrically. The second laboratory assignment is devoted to polar
curves and again focuses on arc lengths and areas enclosed by polar curves.

10.1 Activity: Parametric Curves in the Plane

Prerequisites: Read Sections 10.1 - 10.2 LHE.

In this activity, you will use Mathcad and Maple to visualize and enhance your understanding of
the behavior of some interesting parametric curves in the plane.

Instructions

After reading the comments and studying the worked examples, open a blank Mathcad document
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and create your report there. Remember to enter your team's name at the top of the document.
Upon completion of the assignment, enter the names of all team members who actively participated
in the assignment. Save your work frequently.

Comments

1. Throughout this chapter, you will use Mathcad to plot parametric curves in the plane - here's
how this is done. First, de¯ne the functions x(t) and y(t), as well as the parameter t range
variable. Then, select Create X-Y Plot from theGraphics menu and ¯ll the middle x-axis
placeholder with x(t) and the middle y-axis placeholder with y(t): After you hit the <Enter>
key, the graph of your parametric curve should be obtained, as in the following example

x( )t .t cos( )t y( )t .t sin( )t t ..,0 0.01 10
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Note that we are using the same Mathcad graphing facility as that used in plotting functions

y = f(x): Consequently, all the features of Mathcad plots that we discussed earlier, such as
the graph format, zoom and crosshair, can be used in conjunction with parametric plots.

2. A parametric plot provides a convenient way to visualize the relationship between the func-
tions x(t) and y(t): It does not, however, reveal the correspondence between the values of the
parameter t; and the point (x(t); y(t)).

In Mathcad, we can use add the point to the graph to illustrate that correspondence:
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We ¯rst de¯ne the value of T which we are interested in (this variable name is capitalized so
that it won't interfere with our range variable t): Then, add y(T ) after y(t) and x(T ) after
x(t) (separating the two by a comma in both cases). Finally, double-click on the graph, and
change the "Symbol" for the second trace to a diamond ("dmnd").

By changing the value of T above the graph, you will now be able to "trace" the graph for
varying parameter values.

3. Numerous times in this manual, we invoke Mathcad's "root" function to ¯nd a numerical
approximation to the solution of an equation. In this activity, we will be asking Mathcad
to solve systems of equations. While this cannot be accomplished using the root function,

Mathcad has the "Given ... Find" solve block which can be used for that purpose. The
following example illustrates this approach. We determine the intersections of the ellipse
(x¡1)2

9 + y2

4 = 1 and the hyperbola x2

9 ¡ (y¡1)2

2 = 1
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x 3.5 y 2 <--------- Define initial values of x and y (must be done before 
the keyword "Given" appears)

Given

List all the equations after the keyword "Given"  ( )x 1 2

9

y2

4
1 <---------

(use the button to set up an equation)

x2

9

( )y 1 2

2
1

Typing Find(x,y) followed by the "=" key asks 
Mathcad produce the solution. Values are reported 
in the same order in which the variables were listed 
after the "Find" keyword.

=Find( ),x y
3.125

1.412
<---------

Notice that the initial values of the unknowns should be close to the solution being sought.
Consider the following example:

x 4 y 0 <--------- Different initial values result in ...

Given

( )x 1 2

9

y2

4
1

x2

9

( )y 1 2

2
1

... a different answer (this corresponds to 
another intersection point).

=Find( ),x y
3.98

0.233
<---------

If the initial guess you provided was not su±ciently close to a solution, then Mathcad may
report an error. (Recall that similar consideration has to be given to an initial guess when
using Mathcad's root function.)

4. In this activity, you will be asked to view animations generated using Maple. For reference,
here is the layout of Maple's animation window with a de¯nition of each of its panel buttons.
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You can have these de¯nitions displayed in Maple's status line (at the bottom) if you click

and hold the left mouse button on the appropriate area of the panel.

Example 1

If a circle of radius a rolls along a straight line, then the curve traced by any given point on the
circumference of the circle is called a cycloid. If the given point is initially at the origin, then the
parametric equations which describe the cycloid (derived on p.672 LHE) are given by

x = a(t¡ sin t) and y = a(1¡ cos t):

Plot the cycloid for three revolutions of a circle with radius 1. Based on the geometric interpretation
of the cycloid in terms of a rolling circle, determine the location of the maximum points and cusps
on the graph. Replot the cycloid with a = 3. Has the shape of the cycloid changed? What about
it's size?

Solution

t ..,0 0.1 .6 π a 1 x( )t .a ( )t sin( )t y( )t .a ( )1 cos( )t
  

Maximum points are at (pi,2), (3pi,2) and (5pi,2).  (To find, set dy/dt = 0.) 
Cusps are at x = 0, 2pi, 4pi and 6pi.  (To find, set y=0.)
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The value of the radius, a, only affects the size of the graph, not it's shape, because it only 
appears as a multiplier in the expressions for x and y.   
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Example 2

(a) In Mathcad, graph the parametric curve with the equations x(t) = sin 3t and y(t) =

t sin(4:5t2 + t+ 1) for ¡1 · t · 1:05: Follow the procedure described in Comment 2 to
show the point on the curve corresponding to T = 0:9 .

Solution

x( )t sin( ).3 t y( )t .t sin .4.5 t
2

t 1 t ..,1 0.99 1.05 T 0.9

1 0 1

1

0

1

y( )t

y( )T

,x( )t x( )T
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(b) De¯ne functions slopetan(t) and slopenorm(t) which, at the point on the curve corre-
sponding to t; would calculate the slopes of the tangent and normal lines, respectively.
Evaluate slopetan(T ) and slopenorm(T ):

Solution

The derivative of x(t): xp( )t d

dt
x( )t The derivative of y(t): yp( )t d

dt
y( )t   

Slope of the tangent line: slopetan( )t
yp( )t

xp( )t
=slopetan( )T 1.986

Slope of the normal line: slopenorm( )t
xp( )t

yp( )t
=slopenorm( )T 0.504

(c) De¯ne the linear functions ytan(X) and ynorm(X) whose graphs are the tangent and the
normal lines (respectively) to the curve at the parameter value T = 0:9: Copy your graph
from part (a), and plot ytan(X) and ynorm(X) on it.

Solution

Equation of tangent line: y tan( )X y( )T .slopetan( )T ( )X x( )T
  

Equation of normal line: y norm( )X y( )T .slopenorm( )T ( )X x( )T

X ..,0.1 0.11 0.8 (we choose the range variable that covers x values around x(0.9)=0.427  ).

1 0 1

1

0

1

y( )t

y tan( )X

y norm( )X

y( )T

,,,x( )t X X x( )T

(d) Use Mathcad to determine all the points of horizontal tangency to the curve, and illus-
trate one of these points on the graph.

Solution
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The plot of yp(t) 
enables us to  
estimate the  
location of roots 
of yp(t): 
t= - 0.5,  
t=0.5 and 
t=0.8.

Initial 
guess:

Root 
calculation:

Parameter 
value:

Point of horizontal tangency:

T 0.5 T1 root( ),yp ( )T T =T1 0.584 =x( )T1 0.983 =y( )T1 0.542

T 0.5 T2 root( ),yp ( )T T =T2 0.392 =x( )T2 0.923 =y( )T2 0.342

T 0.8 T3 root( ),yp ( )T T =T3 0.821 =x( )T3 0.627 =y( )T3 0.813

We could numerically check that xp 6= 0 at the three t values obtained above. We can
also visually verify each of these points appears to be a point of horizontal tangency.

For example T T2
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y( )t

y( )T

,x( )t x( )T

(e) Above the graph of part (a), start changing the value of T and watch the markers follow

the curve. Visually estimate the T values that correspond to the self-intersection of the
curve in the ¯rst quadrant - two distinct estimates are needed!

Use a "Given ... Find" solve block to obtain better approximations for these values.

Solution
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T1 0 T2 0.9

Given

y( )T1 y( )T2 x( )T1 x( )T2

Mathcad responds with values of T1 and T2 that satisfy the
constraints.

=Find( ),T1 T2
0.063

0.984

We verify that the curve passes 
through the same point at 
t=0.063 and t=0.984:

=x( )0.063 0.188 =y( )0.063 0.056

=x( )0.984 0.188 =y( )0.984 0.057

T 0.063

1 0 1

1

0

1

y( )t

y( )T

,x( )t x( )T

Problems

1. If a circle of radius a rolls along a straight line, then the curve traced by any given point
at a distance b from the center of the circle is called a trochoid. Think of the point as

located on the spoke of a wheel. If b < a, the point is inside the wheel and the trochoid is
called a curtate cycloid. If b > a, imagine that the point is located outside the wheel on a
spoke which extends beyond the wheel's radius. In this case, the trochoid is called a prolate
cycloid. If b = a, the trochoid is simply called a cycloid.

The parametric equations which describe a trochoid are given by:

x(t) = at¡ b sin t y(t) = a ¡ b cos t

(a) In the remainder of this problem, we shall assume a = 1. This isn't really a restriction
when studying how the shape of a trochoid varies with changing values of a and b.
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Why? Brie°y explain. Identify the shape corresponding to the special case that is truly
di®erent from a = 1.

(b) Use the <Alt>-<Tab> key combination to switch to Program Manager. Double-click
on the Maple icon to enter Maple, and then load the ¯le TROCHOID.MS. Follow the
instructions inside the ¯le. Ask for help if you experience problems. Don't worry about
the details of the Maple code at this time. Simply execute the entire ¯le, by selecting
Execute Worksheet from the Format menu, to see the animation that produces a
cycloid:

x(t) = t¡ sin t y(t) = 1¡ cos(t)

Note that once the animation window opens, you will have to "press" the "PLAY"
button to start the animation (see Comment 4).

After you view the animation, selectCopy from theEditmenu in the animation window.
Now use the <Alt>-<Tab> key combination to go back to Mathcad and paste the plot
into your document.

(c) Use <Alt>-<Tab> to return to Maple. In the TROCHOID.MS document (which should
still be loaded), change the value of b to 0.6 and view the new animation. Copy the plot
into your Mathcad document, following the steps described in part (b).

(d) Repeat part (c), this time changing the value of b to 2. Exit from Maple.

(e) As b decreases toward zero, what do you expect will happen to the shape of the trochoid?
What do you think will happen to the trochoid as b becomes much larger than 1?

(f) To con¯rm your expectations in part (e), on separate plots use Mathcad to graph the

trochoids corresponding to b = 10, 5; 2; 1:3; 1; 0:6;0:2 and 0 on the interval [0;4¼].

2. If a circle of radius b rolls on the inside of a larger circle of radius a, then the curve traced
by any given point on the smaller circle is called a hypocycloid. The parametric equations
which describe the hypocycloid are:

x(t) = (a¡ b) cos t+ b cos(
a ¡ b

b
t) y(t) = (a¡ b) sin t¡ b sin(

a¡ b

b
t)

where t is the central angle of the bigger circle, through which the center of the smaller circle
has travelled. Therefore, one circuit of the smaller circle around the larger circle takes place
for t on [0;2¼]. In questions (a)-(f) below, assume the smaller circle has radius b = 1.

(a) Use <Alt>-<Tab> key combination to switch to Program Manager. Double-click on the
Maple icon. to enter Maple. Open ¯le HYPOCYCL.MS. Ask for help if you are experiencing
problems. (Do not worry about the details of the Maple code at this time.) Execute

the entire ¯le by selecting Execute Worksheet from the Format menu. When the
animation window opens, "click" on the "PLAY" button to see the animation of a
hypocycloid with a = 5. Play the animation again, stopping it when the small circle has
travelled about "half way" around the large circle. Select Copy from the Edit menu
then close the animation window. (Do not close ¯le HYPOCYCL.MS). <Alt>-<Tab> back
to your Mathcad document and paste the plot into your document.
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(b) Use Mathcad to plot the hypocycloid for a = 2;3; 4 and 5 on the interval [0; 2¼]. Describe
what you think the graph will look like if a is any integer larger than 5. Also, brie°y
comment on why the hypocycloid degenerates to a line segment when a = 2.

(c) Return to ¯le HYPOCYCL.MS, change the value of a to 5/2, and play the animation. Note
that the curve is not closed as it was in part (a). Copy and paste the plot into your
Mathcad document. Exit from Maple.

(d) Use Mathcad to graph the hypocycloid discussed in part (c) on the interval [0; 2¼]. Plot
the same hypocycloid on the interval [0; 4¼] to close the curve. Then, on another plot,
let a = 7=2 and graph the hypocycloid on the smallest interval that closes the curve
(such that over a bigger interval, the curve would begin to trace itself again.) Repeat

this for a = 7=3.

(e) Based on the examples in part (d), describe how you would produce a starlike ¯gure, ¯rst
with eight points, and then with any number of points. Verify your answer by plotting
the graph for several fractional values of a.

(f) Let a =
p
26 and plot the hypocycloid for t on [0; 2¼]. How does the graph in this case

compare with the graph for a = 5 that you found in parts (a) and (b)? Try plotting
the curve over longer and longer intervals. Can the curve be closed? Try plotting the
hypocycloid for several other irrational values of a. What can you conclude?

(g) In parts (a)-(f) we assumed that the smaller circle has radius b = 1. Explain why
this is not really a restriction? (Hint: De¯ne c = a=b in the parametric equations of the
hypocycloid.) For what special value of b do the results in parts (a)-(f) not apply? What
curve do you get for that special case? (Hint: Visualize the curve that is generated when

the smaller circle rolls inside the larger circle, as b approaches that special value.)

3. Consider the motion of a spinning Ferris wheel described by the parametric equations:

x1(t) = 20sin
¼t

20
y1(t) = 20¡ 20cos

¼t

20

and a motion of another wheel with equations

x2(t) = 45 + 15sin
¼t

15
y2(t) = 15¡ 15cos

¼t

15

where we take 0 · t · 120:

(a) Use Mathcad to obtain the graphs of both Ferris wheels on the same plot. Of course
the graphs are really circles. You should stretch the plot horizontally so they appear

circular.

(b) Use <Alt>-<Tab> to switch to ProgramManager and enterMaple. Open ¯le FERRIS.MS.
Execute the ¯le by selecting Execute Worksheet from Maple's Format menu.

Play and view the animation which shows the location of two points (x1(t); y1(t)) and
(x2(t); y2(t)) on the spinning Ferris wheels starting at t = 0 and ending at t = 120.
Play it again, stopping the animation when the two points appear closest. Locate the
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coordinates of these two points by placing the tip of the pointer on them and clicking
with the left mouse button. Write down their values for use in part (c) of this problem.
Copy and paste the plot into your Mathcad document.

Exit from Maple.

(c) Use Mathcad to calculate the distance between the two points obtained in part (b).

(d) The value of the distance obtained in part (c) is only a rough estimate of how close
the two points come. Use Mathcad to obtain a more accurate estimate of the minimum
distance between the two points.

(Hint: Begin by plotting the distance as a function of time.)

4. (a) Plot the curve described by the parametric equations: x(t) = 7 + 2 sinh t and y(t) =

¡3+b cosh t for t on the interval [¡2;2] and for b = 1. Describe the direction of increasing
t along the curve.

(b) Replot for b = 0:1; 2; and 5. Describe how the shape of the curve changes as the
parameter b increases. What happens to the curve when b = 0? Describe the direction
of increasing t along the graph when b = 0.

(c) By hand, eliminate the parameter t and obtain the Cartesian equation of the curve in
terms of b. You should recognize it as the equation of a hyperbola. Type the equation
in your document. Now by hand, solve for y in terms of x, and then use Mathcad to
graph the upper and lower parts of the hyperbola on the same plot for b = 1. Add
the asymptotes of the hyperbola to the plot. Explain why only the upper part of the
hyperbola was obtained in part (a).

5. Graph the prolate cycloid x(t) = t¡ 3cos t; y(t) = 1+ 3 sin t on the interval 0 · t · 15:

(a) Find the values of the parameter and the Cartesian coordinates of the point where the
graph ¯rst crosses itself. Follow Example 2e on page 106.

(b) Determine the area and length of the loop formed by the curve.

(c) Calculate the equations for both tangent lines at this point and plot them along with
the original graph.

6. Graph the curve de¯ned parametrically by x(t) = 4t
1+t3

and y(t) = 4t2

1+t3
on the interval

0 < t < 5:

(a) What are the Cartesian coordinates of the point on the graph as t tends to in¯nity.

(b) Find the points of horizontal tangency to the curve and plot the tangent lines at these
points.

(c) Find the arc length of the loop formed by the curve.



Activity: Polar Curves 111

10.2 Activity: Polar Curves

Prerequisites: Read Sections 11.3 - 11.5 LHE.

The objective of this activity is to enhance your understanding of polar curves. You will use
Mathcad to plot polar curves and tangent lines to polar curves. You will also determine the length
of polar curves and ¯nd areas enclosed by polar curves.

Instructions

After reading the comments and studying the worked example, open a blank Mathcad document
and create your report there. Remember to enter your team's name at the top of the document.
Upon completion of the assignment, enter the names of all team members who actively participated
in the assignment. Save your work frequently.

Comments

1. Since a polar curve is a special case of a general parametric curve in the plane, we can use
Mathcad's X-Y Plot mechanism to generate polar plots in the rectangular coordinates, e.g.,

t ..,0 0.05 .2 π r( )t 1 cos( )t   

x( )t .r( )t cos( )t y( )t .r( )t sin( )t

1 0 1 2
2

1

0

1

2

y( )t

x( )t

Additionally, Mathcad o®ers a separate polar plot facility, which can be accessed by selecting
Create Polar Plot from the Graphics menu. We demonstrate its use for the cardioid that
has been pictured above:
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t ..,0 0.05 .2 π r( )t 1 cos( )t

0

30

60

90

120

150

180

210

240

270

300

330

2

1.5

1

0.5
r( )t

t

Note that instead of the y and x placeholders, we now have r and µ placeholders. While for
the polar curves discussed here r is typically a function of µ; Mathcad's polar plots are not

limited to that case.

2. When you create a polar plot in Mathcad, and then select it in a blue frame, Mathcad's
Graphics menu will turn into the Polar Plot menu. Try examining the selections available
on that menu - you will ¯nd many items that closely parallel those we have already seen in the
X-Y Plot case, including Crosshair and Zoom. However, there are signi¯cant di®erences
between the two kinds of plots. For example, there are no placeholders to restrict the µ range
- you can only restrict the r range (why?).

3. One important point, related to the previous comment, is that the lower r placeholder should
always be set to zero - setting it to a nonzero value produces unexpected (and typically
undesirable) results.

Example

(a) Create a polar plot for the polar equation r(µ) = 1+ cos 5µ for µ on the interval [0; 2¼]:

(b) Create the same plot in rectangular coordinates.

(c) At µ = ¼=3; ¯nd the slope of the tangent line and plot it along with the graph.

(d) Find the total area enclosed by one "petal", and the arc length of one petal.

Solution
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(a) (b)

t ..,0 0.01 .2 π r( )t 1 cos( ).5 t x( )t .r( )t cos ( )t y( )t .r( )t sin ( )t

0

90

180

270

2

1

0
r( )t

t
2 0 2

2

0

2

y( )t

x( )t

Note: We use the parameter t for the polar angle µ:

(c)

t
π
3

m

.r( )t cos ( )t .d

d t
r( )t sin ( )t

.r( )t sin ( )t .d

d t
r( )t cos ( )t

=m 5.196 m is the slope of the tangent line at π /3.

x1
.r( )t cos ( )t y 1

.r( )t sin ( )t z ..,2 1.9 2 g( )z y 1
.m z x1

t ..,0 0.01 .2 π x( )t .r( )t cos ( )t y( )t .r( )t sin ( )t

2 1 0 1 2
2

0

2

y( )t

g( )z

,x( )t z

(d) By hand, we find that one petal is given by  π/5 < θ < 3π/5, as shown below.

t ..,
π
5

π
5

0.01
.3 π
5

r( )t 1 cos( ).5 t

0

90

180

270

2

1

0
r( )t

t
0.5 1 1.5 2

0

2

r( )t

π
5

.3
π
5

t
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A .1

2
d

π
5

.3
π
5

tr( )t
2

=A 0.942 L d

π
5

.3
π
5

td

dt
r( )t

2

r( )t
2

=L 4.374

Problems

1. Let r(t) = 1 + b sin ct

(a) Plot r(t) (use Polar Plot) with b = 1 and c = 4 for 0 < t < 2¼: (Use a step size of
0:01 .)

(b) Plot dy=dx with respect to t: For e±ciency, you should ¯nd dr=dt by hand, and use this
expression in the equation for dy=dx: Use Mathcad to ¯nd all the (x;y) points where
the tangent line has a slope of 1=2: How many are there?

(c) Use crosshair and the "root" function to obtain the smallest value of t for which dy=dx =
1=2. From this ¯nd the x and y coordinates of the point on the curve, and plot the curve
and the tangent line. (See Example.)

(d) Once you have successfully completed part (c), copy your entire answer to (c) and paste
it into your document. Repeat the procedure for all other values of t found in part (b).

2. Let r(t) = 1+ b sin(ct), with b = 2 and c = 4: By hand ¯nd (exactly) the t intervals for which

r(t) creates a small petal and a large petal. Con¯rm your answer by graphing r(t) on the
same plot over these two intervals. Use Mathcad to ¯nd the perimeter and area for both a
small petal and a large petal.

3. Find the area of the common interior of r = 2sin µ and r = 1¡ cos µ:

4. Find the area of the region inside r = ¡2cos(3µ) and outside r = 3 +2 sinµ:

5. (a) De¯ne k to be 0 and r(t) to be cos(k cos(k cos t)). Note that r(t) has the form r(t) =
f(cos t) for every value of k. Therefore, its polar graph must be a periodic function of t
with period 2¼. It follows that the polar graph of r(t) for t on [0; 2¼] must be a closed
curve.

Plot the polar graph of r(t) for t on [0; 2¼] using step size 0.01. On another plot, obtain
the Cartesian graph of r(t) as a function of t. Explain why the polar graph is a circle.

(b) Copy and paste your solution to part (a) (de¯nition of k, r(t) and both graphs). In the
copy change the value of k to 1, 2, 3, 4, 5, 6, and 7 and observe how the corresponding

plots change dramatically.

For k = 7, the polar graph should consist of two large petals and many smaller ones, as
shown below. Use Mathcad to ¯nd the area of a large petal.
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1 0 1
1

0

1

6. Find the perimeter of the region of Problem 3.

7. Find the perimeter of the region of Problem 4.

8. Let r(t) = 1 + b sin(ct):

(a) Taking b = 3 and t on the interval [0;2¼]; obtain the graph of r(t) for c = 1;2; 3; 4; and
5. Describe how the number of petals and their relative orientation appear to depend
on integer values of the parameter c.

(b) In the plots obtained in part(a), change the value of b to b = 20. Describe what happens
to the graphs of r(t) for integer values of c when b is large.

(c) Based on your answer to part (b), what can you conclude about the graph of r(t) =

b sin(ct) for integer values of c? Explain.

(d) Taking b = 1=2 and c = 5=2, plot r(t) = 1 + b sin(ct) on an interval which makes the
graph a closed curve. Repeat for c = 5=3 and c = 5=4. What is the smallest interval
required to obtain a closed curve when c = 5=n , for any nonzero integer n ? Does this
interval change if c = 6=n or 7=n? Now take b = 1=2 and c = 2:1, and plot r(t) on the
smallest interval required to close the curve.

(e) Taking b = 2 and c = 4, by hand ¯nd (exactly) the t intervals over which r(t) creates a
small petal and a large petal. Con¯rm your answers by graphing r(t) on the same plot
over these two intervals. Next, use Mathcad to determine the perimeter and area of a
small petal and of a large petal.

9. Given r(µ) = cos(¼ cos µ + ¼
3
) whose polar plot for 0 · µ · 2¼ appears below, use Mathcad

to approximate the area of the shaded region.
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10. Mr. BB's head is described by the polar equation r = 1¡sin t+1:8 sin 3t and t on the interval
[0,2¼]. Find the area and perimeter of his nose, ears, and eyes.

2.5 2 1.5 1 0.5 0 0.5 1 1.5 2 2.5
4

2

0

2

10.3 Homework Help

² After manually sketching the parametric (or polar) curves in the following exercises, use Mathcad
to con¯rm your answer

{ Exercises 3-28 p.674 LHE

{ Exercises 59-64 p.694 LHE

{ Exercises 21-34 p.712 LHE

² As in Example 2 of Section 10.1, several exercises related to tangent lines, vertical/horizontal
tangency etc., can be illustrated using Mathcad:
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{ Exercises 13-28 p.684 LHE

² You can follow the example of Section 10.2 to visualize tangent lines to polar plots, regions
within polar curves, etc.

{ Exercises 39-46 p.694 LHE

{ Exercises 3-12, 27-36 p.703 LHE


